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SoccerPlanner Manual and Software Description 
 

SoccerPlanner helps the amateur coach plan a weekly position plan for a soccer team 

with up to 13 players on the field.  With its ability to customize substitution periods, it 

makes tracking which players are on the field easy with a visible list of available 

substitute players.  Players can be added, removed, or edited on the roster at any time.  

Use the Auto feature to have the software assign positions and substitutes automatically.  

Although it is possible to use the software during an active game with a tablet, for 

example, SoccerPlanner has the ability to print your detailed plan either with text only or 

graphically, duplicating the field format seen on the screen.  Plans can be sent to a printer 

or printed to a PDF file. 

 

SoccerPlanner features: 

 

• Detailed print-outs of each week’s plan 

• Roster Manager with individual player preference and contact details 

• Substitution Period Manager 
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Getting Started 
 

SoccerPlanner creates and reads all data from a folder in C:\Users\Public\Public 

Documents\ called “SoccerPlanner”.  When running the program for the first time after 

installation, you will need to accept the license agreement once. 

 

Begin all sessions by clicking on the ‘Load Team’ button at center screen: 

 

 
 

 
 

If you agree to the terms and conditions of using the SoccerPlanner software, please 

select the ‘I Accept’ button to the lower mid-left of the window.  You can return to read 
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the license agreement at any time while using the software by selecting the License 

Agreement option under the Help menu. 

 

After accepting, you will be taken back to the original start-up screen where you can 

begin by selecting Load Team again.  Once you accept the License Agreement, you will 

not need to do so again unless you remove the aforementioned folder and re-install the 

software. 

 

 
 

If there are no teams established in the SoccerPlanner folder, you will be prompted to 

create a new team and enter its name.  You are given the option of using ‘default’ as the 

team’s name.  Otherwise, please type in the appropriate team’s name in the field that is 

highlighting the word ‘default’ as shown above, and then select the OK button. 

 

 
 

 

Next, you will be shown an initialized, blank field for making position assignments. 
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1. The field shows the maximum 13 player positions recognized by SoccerPlanner.  

After your roster of players is established (described later in this manual), a list of 

those names will appear in the Substitution list (#6).  Those names can be dragged 

to the blank lines at each position. 

2. The Save button is used to save your changes as you build and modify your plan.  

The Copy button is a shortcut to use which allows you to automatically fill the 

period positions shown with either next or previous period’s assignments. 

3. The Period selector is used to move forward and backward through your period 

assignments.  A ‘Period’ is the interval of time for each set of position 

assignments during a single game.  As you move through the periods, you will 

make different position assignments and rotate substitutions on and off the field as 

you would during a real game.  The Game selector moves through each individual 

game’s assignments.   

4. Start Time shows when a Period begins and how long it lasts in minutes.  Total 

Games shows how many games have been created and saved to the planning 

database. 

5. The progress bar shows graphically the amount of time during a single game that 

has elapsed given the period number you are currently viewing.  Each tick mark is 

the end of a period. 

6. The Substitution list shows the players who are on the roster but do not have a 

field assignment during the particular period are you currently viewing. 

7. The + / - buttons located under each column of common field positions toggles 

the number of players in that column.  The – button under the ‘Mid’ positions, for 

example, reduces the number of Mid positions available.  Instead of having two 

center mid positions, you can reduce it to just one or none at all with the – button.  

The + button adds those positions back.  If you are playing 11X11 soccer, you 

would consider reducing the Defense and Mid positions to 3 each, for example. 
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8. The Play Time Grid will show a table of each player and how much time they 

play either by period or by position. 

9. Auto will allow position assignments to be made automatically.  This function 

overwrites any assignments made manually prior to its use.  However, changes 

can be made manually after its use. 

 

The logical order for creating your game’s assignments is as follows: 

 

1) Create or edit your roster 

2) Create or edit your substitution periods 

3) Drag and drop player names from the substitute list onto the field positions 

4) Cycle through all of your periods for a game and repeat step 3 

5) Print your game plan or use the software actively during a game 

 

 

If beginning from scratch with a new team, your first task is to populate your roster.  You 

can do this by selecting ‘Roster Manager’ under the View menu tab at the top. 

 

 
 

This brings up a new window to show you the roster. 
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Roster Manager 

 

 
 

If you have used this software in the past and have an established roster to draw from, 

then you have the option to use the Import feature.  If not, then you must add players one 

at a time using the Add Player button at the lower left.  Be cautious when using the 

Import feature because it wipes away any existing players that you may have already 

entered.  This is to help prevent adding duplicate players.  Therefore, it is best to import 

first, then add and delete as needed.   
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Populate the fields as desired and then select the Save button.  Note that the Position 

Preference will be important if you use the Auto-assign function described later in this 

manual. 

 

 
 

Note that the Roster Manager maintains a count of your players as shown in the upper 

right of the window.  Continue to add your players until your team is complete. 

 

 
 

1. Add a new player 

2. Delete an existing player in the list by clicking on their name in the roster list and 

then selecting the Delete Player button. 

3. Edit and existing player in the list by clicking on their name in the roster list and 

then selecting the Edit Player button. 



8 

 

4. Import an existing roster list.  Note that selecting this option overwrites any 

players you may currently have added.  Import first, then add, delete, and edit. 

5. Send your roster list to a printer or to a PDF file. 

6. Use the Change Team Name button to edit the name of the existing Team you are 

working on. 

7. Save your changes to the roster. 

8. Close out of the Roster Manager.  If you have made changes, you will be asked if 

you want to save those changes.  By selecting no to this prompt, all of your 

changes will be lost and you will return to the main window. 

9. The Roster Manager keeps a count of players on your team. 

 

Period Manager 
 

 
 

The default substitute periods are set every quarter or 16 minutes for a 65-minute game.  

65 minutes is the default game length.  You can change this with the Period Manager, 

also. 
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Note the 65 minute setting next to ‘Total Game Length’.  You can change this to anything 

over 5 minutes and then select the Set button.  Halftime is automatically calculated at 

one-half the total game length rounded down to the nearest integer.  This is important 

because one of your periods will have a length based on the last period of the first half, 

and the last period end time will be based on the total game length. 

 

As an example, you can set a substitute period time every 8 minutes rather than at every 

quarter.  To begin, you can use the up/down arrows to change to Period 2 or by clicking 

on the appropriate row in the table.  Next, select the Insert button.  New Start Tiem and 

New Length will be turned on.  Put an 8 at ‘New Start Time’ and set ‘New Length’ to 8.  

Then select the Apply button.  A row will be added to the table showing a new substitute 

period starting at 8 minutes, lasting for 8 minutes. 
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If you change your mind, click on the row you want to get rid of and then select the 

Delete button. 
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Above is an example of how you can create even 8-minute periods.  Your periods do not 

have to be even.  Any particular period can begin at any time and last for any length of 

time within the game half.  Note that the last period #8 lasts for 9 minutes because the 

game length is 65 minutes instead of 64 minutes.  If we change the game length to 60 

minutes, for example, the last period and the half time, after Period #4, are adjusted 

accordingly as shown below. 

 

 
 

 

If you enter a Total Game Length that is less than the last Period’s Start Time, 56 minutes 

in the scenario shown above, you will get an error message.  When this happens, you 

would need to delete as many end periods as necessary in order to fit the new game 

length.  For example, with the table shown above, if you enter a Total Game Length of 45 

minutes, you would first need to delete periods 7 and 8 so that the last Start Time 

showing, 40 minutes, is less than the new Total Game Length. 
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Each time you save your changes in the Period Manager, the progress bar at the bottom of 

the main screen updates accordingly.  Note the increased number of tick marks now, each 

representing a new Period start time. 

 

Setting Position Assignments 

 
To fill the positions from the substitution list into the field positions, click and drag on a 

name in the substitution list and drag it over to the desired position assignment.  It is 

strongly suggested that you adjust the positions in the field to configure to the right 

number of players and the desired number of positions in defense, mid-field, and 

forwards before making the assignments.  For example, for a 11X11 game, you may want 

to eliminate one defense and one mid-field position to go from the default 13 players to 

11 players.  There are many combinations to choose and they can be changed each period 

or each game.  You can play 4-3-4 in the first half, for example, and then switch to 3-4-4 

in the second half.  Use the +/- buttons until you have the desired position configuration. 
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Note in the example above that all names appear in black text.  This indicates that you 

have made position assignments that correlate to each player’s position preference, if any.  

If a player who prefers offense is put in a defense position, the player’s name will appear 

in red text. 

 

Once your assignments are complete for any particular period, select the Save button in 

the lower left of the window to keep these changes.  If you do not, and proceed to change 

the period or game, you will be prompted if you want to save. 

 

In this example, press the Period up arrow or go to the View menu and select the next 

numerical period from the drop-down menu. 
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Note that all default field positions re-appear.  You can either re-adjust the positions 

manually with the +/- buttons or select the Copy button.  You will be asked if you want to 

copy the previous period or copy from the next period.  In this case, you would want to 

copy from the previous period, Period #1. 

 

Not only will the positions be copied from the previous period, but the same players will 

be copied to the new period’s positions as well.  To change an assignment, click and drag 

a player’s name from the substitution list and drag to the position of choice.  The player’s 

name from the field position who was there, will be re-listed in the substitution list. 

 

You can double-click on a name in the field to reset that position to blank. 

 

You can click and drag on a player from one position to another position.  The first 

selected position will be reset to blank. 

 

Auto Player Assignments 
 

The Auto function makes player position assignments based on player preferences as best 

it can.  There may be exceptions based on how many of each preference is available per 

the position layout on the field.  For example, if most players prefer offense, then some 

players will be assigned to defense regardless in order to fill all positions and to rotate 

players off and on the field. 

 

This function is activated with the Auto button in the lower right portion of the main 

screen or under the Edit menu at the top.  Note that the Period scheme is not altered.  It is 

recommended to set the Period times with the Period Manager first before running the 

Auto feature. 

 

 
 

 

Player Time Summary 
 

You can view a summary of player assignments two ways.  One way is to use the Player 

Time Summary option under the View menu at the top. 
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Click on name in the list to view a summary of that Player’s assignments. 

 

 
 

Note that in the example above, the player is set to play 34 minutes out of the 60 minute 

game and that all position assignments are displayed in black text which indicates that 

their position preference, Defense in this case, is being met. 
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You can select the Show Whole Team button to see a table of all players at once.  This 

function matches the Play Time Grid in the main screen, located under the substitute list 

and next to the Auto button. 

 

Whole Team Player Time in Field Summary 
 

 
 

In the example shown above, each player on the roster is listed in the table in the first 

column.  The total times in minutes for each position is shown in the columns.  The last 

column shows total time on the field for the player in that row.  Note that some times are 

shown in red in this example, indicating that the player in that position had a different 

preference. 

 

Each player shown in the table above plays approximately half of the game.  The Auto 

function assumes that there would be one player assigned to the goalie position per half. 

 

Clicking on View Periods shows the table with the Periods as column headers. 
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This window can be kept open while you return to the main window to make manual 

adjustments.  When you return to this window after saving your changes, select the 

Refresh button to update the summary table. 

 

Edit Position Names 
 

 
 

You can change the names of the position names shown in the box titles at each position 

on the field.  Go to the Edit menu and select the Position Names option. 

 

 
 

Type your name changes in the boxes below each position name.  Note in the example 

above that Left Center Mid will become simply Middle Halfback.  When the field 

positions were adjusted in this example, the number of Mid positions was reduced from 

four to three.  When this happened, the Right Center Mid position was eliminated.  It is 
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therefore unnecessary to rename that position in this case.  The same would be true for 

any of the position groups.  Right Center Defense, Right Center Mid, and Right Striker 

positions get eliminated first when the – button is used. 

 

Select the Save button when you are finished.  Select Close to return to the main screen. 

 

Flip Field Direction 
 

 
 

To help simulate a real game, it is possible to flip the field direction as it is graphically 

shown on the screen.  This typically happens at half time. 
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You will need to do this for each period you desire to see the field flipped.  Select the Flip 

Field Direction option from the Edit menu and then select the Save button to keep the 

change. 

 

Printing A Game Plan 
 

To print your game plan, select the Print Plan option under the File menu. 

 

 
 

 
 

There are two formats to print, text only and Graphics.  Text only does not show the field 

formation, rather it lists each period sequentially. 
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Printing with Graphics duplicates what you see in the main screen for each period. 
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If there are problems with printing to a file, try saving to the C:\Users\Public\Documents 

folder and make all other program windows are minimized in the background.  The 

program makes screen shots and having other programs open while printing may interfere 

with this process. 

 

 

Import Team Plan 
 

The Import Team Plan option under the File menu allows you to select previously created 

plan file to use with your current team.   
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Plan files contain team member names, formations, and period structure.  This option 

only checks to see if the team member names in the selected file match your current 

roster.  If they do not, you will be asked permission to proceed with the import. 

 

License Agreement 
 

From The SoccerPlanner Author  

software LICENSE AGREEMENT FOR SoccerPlanner FOR WINDOWS 

 

PLEASE READ THIS software LICENSE AGREEMENT ("LICENSE") CAREFULLY 

BEFORE USING SoccerPlanner software.  BY USING SoccerPlanner, YOU ARE 

AGREEING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF YOU DO NOT 

AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE software.  

 

1. General. The SoccerPlanner software, documentation and any fonts accompanying this 

License whether on disk, in read only memory, on any other media or in any other form 

(collectively the SoccerPlanner ") are licensed, not sold, to you by SoccerPlanner Author 

for use only under the terms of this License, and SoccerPlanner Author reserves all rights 

not expressly granted to you. The terms of this License will govern any software 

upgrades provided by SoccerPlanner Author that replace and/or supplement the original 

SoccerPlanner Author product, unless such upgrade is accompanied by a separate license 

in which case the terms of that license will govern.   

 

Title and intellectual property rights in and to any content displayed by or accessed 

through the SoccerPlanner software belongs to the respective content owner. Such 

content may be protected by copyright or other intellectual property laws and treaties, and 

may be subject to terms of use of the third party providing such content. This License 

does not grant you any rights to use such content. 

 

2. Permitted License Uses and Restrictions.  

A. Subject to the terms and conditions of this License, you are granted a limited non-

exclusive license to install and use the SoccerPlanner software. You may not make the 

SoccerPlanner software available over a network where it could be used by multiple 

computers at the same time. You may make one copy of the SoccerPlanner software in 

machine-readable form for backup purposes only; provided that the backup copy must 

include all copyright or other proprietary notices contained on the original.  

 

B. You may not and you agree not to, or to enable others to, copy except as expressly 

permitted by this License), decompile, reverse engineer, disassemble, attempt to derive 

the source code of, decrypt, modify, create derivative works of the SoccerPlanner 

software, or any part thereof (except as and only to the extent any foregoing restriction is 

prohibited by applicable law).  Any attempt to do so is a violation of the rights of 

SoccerPlanner Author and its licensors of the SoccerPlanner software. 

 

3. Transfer. You may not rent, lease, lend, redistribute or sublicense the SoccerPlanner 

software. You may, however, make a one-time permanent transfer of all of your license 
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rights to the SoccerPlanner software to another party, provided that: (a) the transfer must 

include all of the SoccerPlanner software, including all its component parts, original 

media, printed materials and this License; (b) you do not retain any copies of the 

SoccerPlanner software, full or partial, including copies stored on a computer or other 

storage device; and (c) the party receiving the SoccerPlanner software reads and agrees to 

accept the terms and conditions of this License.  

 

4. Termination. This License is effective until terminated. Your rights under this License 

will terminate automatically without notice from SoccerPlanner Author if you fail to 

comply with any term(s) of this License. Upon the termination of this License, you shall 

cease all use of the SoccerPlanner software and destroy all copies, full or partial, of the 

SoccerPlanner software. 

 

5. Limited Warranty on Media. SoccerPlanner Author warrants the media on which the 

SoccerPlanner software is recorded and delivered by SoccerPlanner Author, if applicable, 

to be free from defects in materials and workmanship under normal use for a period of 

ninety (90) days from the date of original retail purchase. Your exclusive remedy under 

this Section shall be, at SoccerPlanner Author's option, a refund of the purchase price of 

the product containing the SoccerPlanner software or replacement of the SoccerPlanner 

software which is returned to SoccerPlanner Author or an SoccerPlanner Author 

authorized representative with a copy of the receipt. THIS LIMITED WARRANTY AND 

ANY IMPLIED WARRANTIES ON THE MEDIA INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY 

QUALITY, AND OF FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN 

DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL 

PURCHASE. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW 

LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY 

NOT APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE 

ONLY WARRANTY MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER 

WARRANTIES (IF ANY) CREATED BY ANY DOCUMENTATION OR 

PACKAGING. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL 

RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY 

JURISDICTION. 

 

6. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT 

USE OF THE SoccerPlanner software (AS DEFINED ABOVE) AND SERVICES (AS 

DEFINED BELOW) IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO 

SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH 

YOU. EXCEPT FOR THE LIMITED WARRANTY ON MEDIA SET FORTH ABOVE 

AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE 

SoccerPlanner software AND SERVICES ARE PROVIDED "AS IS", WITH ALL 

FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND SoccerPlanner Author 

AND SoccerPlanner AUTHOR'S LICENSORS (COLLECTIVELY REFERRED TO AS 

"SoccerPlanner Author" FOR THE PURPOSES OF SECTIONS 6 AND 7) HEREBY 

DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE 

SoccerPlanner software AND SERVICES, EITHER EXPRESS, IMPLIED OR 
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STATUTORY, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 

AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, 

OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET 

ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. 

SoccerPlanner Author DOES NOT WARRANT AGAINST INTERFERENCE WITH 

YOUR ENJOYMENT OF THE SoccerPlanner software OR SERVICES, THAT THE 

FUNCTIONS CONTAINED IN THE SoccerPlanner software OR SERVICES WILL 

MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE SoccerPlanner 

software OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 

DEFECTS IN THE SoccerPlanner software OR SERVICES WILL BE CORRECTED. 

YOU FURTHER ACKNOWLEDGE THAT THE SoccerPlanner software IS NOT 

INTENDED OR SUITABLE FOR USE IN SITUATIONS OR ENVIRONMENTS 

WHERE THE FAILURE OF, OR ERRORS OR INACCURACIES IN THE CONTENT, 

DATA OR INFORMATION PROVIDED BY, THE SoccerPlanner software COULD 

LEAD TO DEATH, PERSONAL INJURY, MONETARY LOSS, OR SEVERE 

PHYSICAL OR ENVIRONMENTAL DAMAGE, INCLUDING WITHOUT 

LIMITATION THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 

NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, LIFE 

SUPPORT OR WEAPONS SYSTEMS. NO ORAL OR WRITTEN INFORMATION OR 

ADVICE GIVEN BY SoccerPlanner Author OR AN SoccerPlanner Author 

AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY. SHOULD THE 

SoccerPlanner software OR SERVICES PROVE DEFECTIVE, YOU ASSUME THE 

ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 

WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A 

CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS MAY NOT APPLY 

TO YOU.   

 

7. Limitation of Liability. THE USER AGREES THAT IN NO EVENT SHALL 

SoccerPlanner Author BE LIABLE FOR PERSONAL INJURY, MONETARY LOSS, OR 

ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES 

WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 

PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER 

COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO 

YOUR USE OR INABILITY TO USE THE SoccerPlanner software OR SERVICES, 

HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY 

(CONTRACT, TORT OR OTHERWISE) AND EVEN IF SoccerPlanner Author HAS 

BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME 

JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY FOR 

PERSONAL INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO 

THIS LIMITATION MAY NOT APPLY TO YOU.  

7a. IF THIS SOFTWARE IS USED IN CONJUNCTION WITH ANY FORM OF 

PRIVATE OR COMMERCIAL WAGERING OR GAMBLING, THE USER AGREES 

THAT IN NO EVENT SHALL THE SoccerPlanner Author BE LIABLE FOR 

MONETARY LOSS OR PERSONAL INJURY RESULTING FROM INCORRECT 

PREDICTIONS OR FORECASTS FROM USE OF THIS SOFTWARE. 
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8. Export Control. You may not use or otherwise export or reexport the SoccerPlanner 

software except as authorized by United States law and the laws of the jurisdiction in 

which the SoccerPlanner software was obtained. In particular, but without limitation, the 

SoccerPlanner software may not be exported or re-exported (a) into any U.S. embargoed 

countries or (b) to anyone on the U.S. Treasury Department's list of Specially Designated 

Nationals or the U.S. Department of Commerce Denied Person’s List or Entity List. By 

using the SoccerPlanner software, you represent and warrant that you are not located in 

any such country or on any such list. You also agree that you will not use these products 

for any purposes prohibited by United States law, including, without limitation, the 

development, design, manufacture or production of missiles, or nuclear, chemical or 

biological weapons. 

 

9. Government End Users. The SoccerPlanner software and related documentation are 

"Commercial Items", as that term is defined at 48 C.F.R. §2.101, consisting of 

"Commercial Computer software" and "Commercial Computer software 

Documentation", as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as 

applicable.  Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §227.7202-1 through 

227.7202-4, as applicable, the Commercial Computer software and Commercial 

Computer software Documentation are being licensed to U.S. Government end users (a) 

only as Commercial Items and (b) with only those rights as are granted to all other end 

users pursuant to the terms and conditions herein. Unpublished-rights reserved under the 

copyright laws of the United States. 

 

10. Controlling Law and Severability. This License will be governed by and construed in 

accordance with the laws of the State of Washington, as applied to agreements entered 

into and to be performed entirely within Washington between Washington residents. This 

License shall not be governed by the United Nations Convention on Contracts for the 

International Sale of Goods, the application of which is expressly excluded. If for any 

reason a court of competent jurisdiction finds any provision, or portion thereof, to be 

unenforceable, the remainder of this License shall continue in full force and effect.   

 

11. Complete Agreement; Governing Language. This License constitutes the entire 

agreement between the parties with respect to the use of the SoccerPlanner software 

licensed hereunder and supersedes all prior or contemporaneous understandings 

regarding such subject matter, with the exception of any additional terms and conditions 

you are required to accept if you choose to use SoccerPlanner Author's online store which 

will govern your use of such store and any Services you purchase through that store. No 

amendment to or modification of this License will be binding unless in writing and 

signed by SoccerPlanner Author. Any translation of this License is done for local 

requirements and in the event of a dispute between the English and any non-English 

versions, the English version of this License shall govern. 

 

12. Third Party Acknowledgements and Terms. Portions of the SoccerPlanner software 

utilize or include third party names and trademarks and other copyrighted material. Your 

use of such material is governed by their respective terms.  
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13. Miscellaneous Provisions. These TOS will be governed by and construed in 

accordance with the laws of the State of Washington, without giving effect to its conflict 

of laws provisions or your actual state or country of residence. If for any reason a court of 

competent jurisdiction finds any provision or portion of the TOS to be unenforceable, the 

remainder of the TOS will continue in full force and effect.  

 

These TOS constitute the entire agreement between the parties with respect to the subject 

matter hereof and supersedes and replaces all prior or contemporaneous understandings 

or agreements, written or oral, regarding such subject matter. Any waiver of any 

provision of the TOS will be effective only if in writing and signed by SoccerPlanner 

Author.  

 

            

Rev. January 4, 2026 


